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Simulink® 3D Animation™ Release Notes

Summary by Version
This table provides quick access to what’s new in each version. For
clarification, see “Using Release Notes” on page 2.

Version (Release) New Features and
Changes

Version
Compatibility
Considerations

Fixed Bugs and
Known Problems

Latest Version
V6.0 (R2011b)

Yes
Details

No Bug Reports

V5.3 (R2011a) Yes
Details

No Bug Reports
Includes fixes

V5.2 (R2010b) Yes
Details

Yes
Summary

Bug Reports
Includes fixes

V5.1.1 (R2010a) Yes
Details

No Bug Reports
Includes fixes

V5.1 (R2009b) Yes
Details

Yes
Summary

Bug Reports
Includes fixes

V5.0 (R2009a) Yes
Details

None Bug Reports
Includes fixes

V4.8 (R2008b) Yes
Details

None Bug Reports
Includes fixes

V4.7 (R2008a) Yes
Details

None Bug Reports
Includes fixes

V4.6 (R2007b) Yes
Details

None Bug Reports
Includes fixes

V4.5 (R2007a) Yes
Details

No Bug Reports
Includes fixes

V4.4 (R2006b) Yes
Details

Yes
Summary

Bug Reports
Includes fixes

V4.3 (R2006a) Yes
Details

No Bug Reports
Includes fixes

V4.2.1 (R14SP3) No No Bug Reports
Includes fixes
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Version (Release) New Features and
Changes

Version
Compatibility
Considerations

Fixed Bugs and
Known Problems

V4.2 (R14SP2+) Yes
Details

No Known problems

V4.1 (R14SP2) Yes
Details

No Fixed bugs

V4.0.1 (R14SP1) No Yes
Summary

Fixed bugs

V4.0 (R14) Yes
Details

No Fixed bugs

V3.1 (R13SP1) Yes
Details

No Known problems

V3.0 (R13) Yes
Details

Yes
Summary

No bug fixes

Using Release Notes
Use release notes when upgrading to a newer version to learn about:

• New features

• Changes

• Potential impact on your existing files and practices

Review the release notes for other MathWorks® products required for this
product (for example, MATLAB® or Simulink®). Determine if enhancements,
bugs, or compatibility considerations in other products impact you.

If you are upgrading from a software version other than the most recent one,
review the current release notes and all interim versions. For example, when
you upgrade from V1.0 to V1.2, review the release notes for V1.1 and V1.2.
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Summary by Version

What Is in the Release Notes

New Features and Changes

• New functionality

• Changes to existing functionality

Version Compatibility Considerations

When a new feature or change introduces a reported incompatibility between
versions, the Compatibility Considerations subsection explains the
impact.

Compatibility issues reported after the product release appear under Bug
Reports at the MathWorks Web site. Bug fixes can sometimes result
in incompatibilities, so review the fixed bugs in Bug Reports for any
compatibility impact.

Fixed Bugs and Known Problems

MathWorks offers a user-searchable Bug Reports database so you can view
Bug Reports. The development team updates this database at release time
and as more information becomes available. Bug Reports include provisions
for any known workarounds or file replacements. Information is available
for bugs existing in or fixed in Release 14SP2 or later. Information is not
available for all bugs in earlier releases.

Access Bug Reports using your MathWorks Account.

Documentation on the MathWorks Web Site
Related documentation is available on mathworks.com for the latest release
and for previous releases:

• Latest product documentation

• Archived documentation
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Version 6.0 (R2011b) Simulink 3D Animation
This table summarizes what is new in Version 6.0 (R2011b).

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

Yes
Details below

No Bug Reports

• “VR Source Block” on page 4

• “Triad of Coordinate Axes” on page 4

• “Controlling Full-Screen Mode” on page 5

• “Global Coordinates for vrnode Objects” on page 5

• “3D World Editor Enhancements” on page 6

• “Specify a Default Viewpoint From the Command Line” on page 7

• “New or Enhanced Demos” on page 7

• “Legacy Viewer” on page 7

VR Source Block
The VR Source block provides access to values from virtual world fields that
you specify in the Block Parameters dialog box as inputs during simulation.
This functionality supports activities such as using the VR Source block to
register user interactions with the virtual world. You can pass to the model
those values that can affect the simulation of a model.

Triad of Coordinate Axes
To help you visualize changes in the orientation (coordinate axes) of nodes in
a virtual world, the 3D World Editor virtual world display pane includes a
triad of red, green, and blue arrows. These arrows are always parallel with
global x, y, and z coordinate axes. The triad displays changes in orientation
as you navigate in a virtual world.

4
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Version 6.0 (R2011b) Simulink® 3D Animation™

Also, you can add a triad to the Simulink® 3D Animation™ Viewer.

For details about using the triad in the 3D World Editor, see “Coordinate
Axes Triad”.

For details about using the triad in the Simulink 3D Animation Viewer, see
“Display a Coordinate Axes Triad”.

Controlling Full-Screen Mode
The Simulink 3D Animation viewer navigation panel now includes a
full-screen mode toggle button ( ) to facilitate moving in and out of
full-screen display mode.

You can also enable full-screen mode using the new View > Fullscreen
Mode menu option.

Global Coordinates for vrnode Objects
When you read the positions and rotations of vrnode types such as Transform
and Viewpoint, you can now use global coordinates. Global coordinates are
very useful, for example, when you are tracking a robot end-effector using
tracers that you create independently from the VRML hierarchy of the robot.
For details, see the documentation for the vrnode function.
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3D World Editor Enhancements
R2011b includes the following 3D World Editor enhancements:

• “Template Files” on page 6

• “Copy Nodes Between VRML Files” on page 6

• “Sensing Objects Added to Components Library” on page 6

• “Improved VRML Script Editing” on page 7

• “Improved VRML Tree Structure Pane” on page 7

Template Files
The 3D World Editor includes template VRML files that you can use as a
starting point for creating virtual reality worlds. Some examples of templates
are the Earth, roads, sea, and terrains virtual world templates. For details,
see “Template VRML Files”.

Add and Paste Nodes Throughout the Hierarchy
In the Tree structure pane, you can add or paste nodes at the beginning or
end of the node list, as well as at the end of a node. See “Adding Objects” and
“Copying and Pasting a Node” for more information.

Copy Nodes Between VRML Files
You can copy nodes between VRML files. For details, see “Copying and
Pasting Between Virtual Worlds”.

Sensing Objects Added to Components Library
The Components library now includes sensing objects. Some examples of
sensing objects are:

• Push buttons

• Toggle buttons

• 2D setpoint area

For information, see “Add VRML Sensors to Virtual Worlds”.

6



Version 6.0 (R2011b) Simulink® 3D Animation™

Improved VRML Script Editing
The 3D World Editor includes enhancements to make VRML script editing
easier. You can:

• Add script interface elements by right-clicking a Script node.

• Edit URL code in an edit box.

For more information, see “Editing VRML Scripts”.

Improved VRML Tree Structure Pane
The Tree structure pane displays icons to visually distinguish between node
field types (field, eventIn, eventOut, and exposedField).

Specify a Default Viewpoint From the Command Line
You can now specify a default viewpoint at the command line, using the
vrview function with a pound sign (#), followed by the name of a viewpoint.
For example:

vrview('vrlights.wrl#Ocean')

New or Enhanced Demos
The new vrcrane_panel demo uses an operator control panel to set the
setpoint. The setpoint is the desired position of the load. The demo uses
the VR Source block.

The demo previously named vrbuttons is now vrdemo_panel. The
vrdemo_panel demo uses sensing objects that are now available in the 3D
World Editor Components library. You can place the example control panel in
your virtual worlds. You can control a simulation or visualize certain virtual
world properties by using signals from virtual world sensors in a simulation
model.

Legacy Viewer
The legacy viewer is not recommended. Use the “Simulink 3D Animation
Viewer” or other supported VRML viewer instead.

7
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Version 5.3 (R2011a) Simulink 3D Animation
This table summarizes what is new in Version 5.3 (R2011a).

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

Yes
Details below

No Bug Reports
Includes fixes

• “Geometric and Background Objects Added to 3D World Editor Library”
on page 8

• “Switching Between Bindable Nodes” on page 9

• “3D World Editor Accessible from the Start Menu” on page 9

• “Preference Options for 3D World Editor Startup Position” on page 9

• “3D World Editor Option to Hide Default Values” on page 9

• “Node Fields Are Listed Before Node Children Fields in 3D World Editor”
on page 10

• “Setting Viewpoint Values in the 3D World Editor Based on Camera
Position” on page 10

• “Faster Texture Handling” on page 10

• “New Demos” on page 10

Geometric and Background Objects Added to 3D
World Editor Library
The 3D World Editor library includes geometric objects, such as a
Sphere object. Access the geometric objects from the Nodes > Insert
From > Components Library > Shapes menu.

The 3D World Editor library also includes background objects, such as a
two-tone blue background object. Access the background objects from the
Nodes > Insert From > Components Library > Backgrounds menu.

8
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Version 5.3 (R2011a) Simulink® 3D Animation™

Switching Between Bindable Nodes
You can switch between multiple Bindable nodes of the same type
(Background, Fog, NavigationInfo or Viewpoint nodes) in the 3D Work
Editor. By default, the first node of multiple instances of a Bindable node
is active.

For Background, Fog, and NavigationInfo nodes, right-click the node that
you want to make active and select the Bind menu item.

As you could in releases prior to R2011a, to make an instance of a Viewpoint
node active, right-click the node that you want to be active and select the
Go to viewpoint menu item.

3D World Editor Accessible from the Start Menu
You can open the 3D World Editor using the MATLAB Start button. Select
Simulink > Simulink 3D Animation > 3D World Editor.

Preference Options for 3D World Editor Startup
Position
The Simulink 3D Animation Preferences pane includes the following two
options for specifying the startup position of the 3D World Editor:

• To specify the default location for the 3D World Editor, select 3D World
Editor > Position, and specify the pixel location for the upper-left and
the lower-right corners (for example, [96 120 862 960]).

• To have the 3D World Editor open in the same location where the editor
was last exited, select 3D World Editor > Save position on exit.

3D World Editor Option to Hide Default Values
To simplify the tree view in the 3D World Editor, you can hide default VRML
values. To hide default values, select the Tree > Hide Default Values
menu item. To return to viewing default values, clear the Hide Default
Values option.
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Node Fields Are Listed Before Node Children Fields
in 3D World Editor
Node fields appear at the top of the list of nodes in the tree structure pane of
the 3D World Editor.

In the R2010b version of the 3D World Editor, node children appeared before
the node’s own fields. However, virtual worlds created in R2010b do not
require any changes to work in R2011a.

Setting Viewpoint Values in the 3D World Editor
Based on Camera Position
You can use the current camera position to interactively specify a viewpoint
in the 3D World Editor. Right-click a Viewpoint node in the tree structure
pane and select the Copy values from current camera option.

1 Navigate to a position in the scene that you want.

2 In the tree structure pane, right-click a Viewpoint node .

3 Select Copy values from current camera.

Faster Texture Handling
Simulink 3D Animation renders textures more quickly than previously.
The performance improvement is especially noticeable for 64-bit Windows®

platforms.

New Demos
R2011a includes the following new demos:

• Vehicle Dynamics Visualization with Live Rear Mirror Image
(vr_octavia_mirror)

Illustrates the capability of the VR Sink block to process a video stream on
input. The demo also creates the impression of a live reflection.

• Vehicle Dynamics Visualization - Simulation of a Double Lane-Change
Manoeuvre (vr_octavia_2cars.mdl)

10
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Illustrates multiple-object scenario visualizations.
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Version 5.2 (R2010b) Simulink 3D Animation
This table summarizes what is new in Version 5.2 (R2010b).

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

Yes
Details below

Yes
Summary

Bug Reports
Includes fixes

• “3D World Editor” on page 12

• “stl2vrml Function” on page 14

• “Simulink 3D Animation Viewer Supported on Linux” on page 14

3D World Editor
R2010b introduces the 3D World Editor, which is a built-in VRML editor that
works on all platforms supported for the Simulink 3D Animation product.

You can use the 3D World Editor instead of, or in addition to, the V-Realm
Builder editor (which also is included with the Simulink 3D Animation
product) or with another VRML virtual world editor.

The 3D World Editor includes three panes:

• Tree structure pane, which shows the hierarchy for the virtual world you
are editing

• Virtual scene display pane, which reflects your edits

• Edit pane, where you can change values for node items

12
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For details about using the new editor, see “Using the 3D World Editor”.

When you install R2010b in a different location from where any previous
MATLAB releases are installed, the 3D World Editor is the default editor.
If you are upgrading from a previous release, then you need to change your
preferences, as described in the “Simulink® 3D Animation Compatibility
Summary” on page 55 section below.

Compatibility Considerations
The VRML Editor command line preference in R2010b is now *BUILTIN.

Also, in R2010b the Antialiasing preference check box is enabled. To access
the Antialiasing preference,

If you are upgrading from a previous release to R2010b, we recommend that
you reset your preferences. You can use one of these approaches:

13



Simulink® 3D Animation™ Release Notes

• Reset all your preferences to match the default preference settings for
R2010b.

• Explicitly reset the VRML Editor command line and Antialiasing
preferences.

To reset your preferences to the R2010b default settings, at the MATLAB
command line, enter:

vrsetpref factory;

To set the individual preferences explicitly:

1 In MATLAB, select File > Preferences > Simulink 3D Animation

2 In the Simulink 3D Animation Preferences dialog box, set the VRML
Editor command line preference to *BUILTIN.

3 In the Simulink 3D Animation preferences tree view, select the Figure
node and then open the Rendering tab.

4 Clear the Antialiasing check box.

stl2vrml Function
You can use the new stl2vrml function to convert STL files to VRML format.

Simulink 3D Animation Viewer Supported on Linux
You can now use the Simulink 3D Animation viewer on Linux platforms. You
can use MATLAB Handle Graphics features with this viewer.

14
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Version 5.1.1 (R2010a) Simulink 3D Animation
This table summarizes what is new in Version 5.1.1 (R2010a).

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

Yes
Details below

No Bug Reports
Includes fixes

• “vrnode/getfield Now Returns Field values of SFNode and MFNode Types”
on page 15

• “VRML Field Data Types” on page 16

• “Camera Bound to Viewpoint Shortcut Change” on page 16

• “Navigation Method Changes” on page 16

• “Updated vrphysmod” on page 16

• “VR Sink Block Now Supports Setting Node eventIn Events” on page 16

• “vrmorph Demo” on page 17

• “Some Dialog Boxes Are No Longer Modal” on page 17

vrnode/getfield Now Returns Field values of SFNode
and MFNode Types
The vrnode/getfield function now provides access to the SFNode and MFNode
field values. This access improves virtual scene node management. It enables
you to access the entire virtual world structure and get the properties of all
nodes present in the scene, including unnamed nodes. This capability is most
useful for advanced scene manipulations. For example, adding nodes to
unnamed nodes or setting properties for these nodes. See “VRML Field Data
Types” in the Simulink 3D Animation User’s Guide.

In previous releases, this capability was available only for nodes named using
the DEF keyword.

15
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VRML Field Data Types
The software now supports the SFImage VRML field data type. This support
enables dynamic object texturing and playback of video sequences in the
virtual scene. See “VRML Field Data Types” in the Simulink 3D Animation
User’s Guide.

Camera Bound to Viewpoint Shortcut Change
The Camera Bound to Viewpoint shortcut is now Ctrl+F10. In previous
releases, this shortcut was F10.

Navigation Method Changes
You can now select None for the Navigation > Method context menu. This
option disables mouse navigation in the virtual scene viewer. The Shift+N
keyboard command provides this option.

Updated vrphysmod
The vrphysmod function has been enhanced to automatically link multiple
SimMechanics™ models imported through SimMechanics Link to a single
virtual scene that contains these components. This means that if your model
contains several VR Sink blocks that refer to the same VRML file, this
function attempts to consolidate the animation signals of that virtual scene
into one VR Sink block.

VR Sink Block Now Supports Setting Node eventIn
Events
The VR Sink block now supports setting node eventIn events that do not
have any field or exposeField associated with them. This improves the
ability to control virtual scene, in particular using scripts and interpolators.
For example, you can now define an object trajectory using a VRML
PositionInterpolator. During simulation, you can define the current position
of the object on the trajectory by setting the set_fraction eventIn event of
that interpolator.

16
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vrmorph Demo
The vrmorph demo has been updated to reflect support for Simulink
variable-size signals.

Some Dialog Boxes Are No Longer Modal
The Capturing and Recording Parameters and Create new viewpoint dialog
boxes are no longer modal dialog boxes. This means that you can access other
windows while these dialog boxes are active. For example, you can now change
recording parameters or create viewpoints while a simulation is running.
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Version 5.1 (R2009b) Simulink 3D Animation
This table summarizes what is new in Version 5.1 (R2009b).

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

Yes
Details below

Yes
Summary

Bug Reports
Includes fixes

• “Alternate Mode of Virtual Scene Viewer Now Default” on page 18

• “Support on the 64-Bit Intel Macintosh Platform” on page 19

• “VRML Files Recognized in MATLAB Current Folder Browser” on page 19

• “Changed vr.canvas Units Property Default” on page 19

• “Improved Performance of Orbisnap in Remote Configuration” on page 19

Alternate Mode of Virtual Scene Viewer Now Default
The alternate mode of virtual scene viewer introduced in Version 5.0
(R2009a) is now the default viewer for all supported platforms (except for
Linux® platforms). Using vrsetpref to set the DefaultViewer property to
'internal' enables this version of the virtual scene viewer.

To reactivate the legacy (former) viewer, use vrsetpref to set the
DefaultViewer property to 'internalv4'.

Note If you are running the Simulink 3D Animation software on a
Linux platform, the default viewer continues to be the legacy viewer.
The legacy viewer does not support MATLAB figures. If you have a
Linux platform and want to access the MATLAB figure capability for
the viewer, install the hardware-accelerated OpenGL® rendering engine
first. Otherwise, the Simulink 3D Animation software cannot properly
display the viewer window. You can then activate the new viewer by typing
vrsetpref('DefaultViewer','internalv5') in the MATLAB Command
Window.

18
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Compatibility Considerations
The alternate mode of virtual scene viewer introduced in Version 5.0 (R2009a)
is now the default viewer for all supported platforms (except for Linux
platforms). At a minimum, this viewer provides the same functionality as
the legacy viewer.

Support on the 64-Bit Intel Macintosh Platform
The Simulink 3D Animation software now supports the 64-bit Intel®

Macintosh® platform.

VRML Files Recognized in MATLAB Current Folder
Browser
The MATLAB Current Folder browser now supports .wrl files. This support
enables you to perform standard MATLAB file operations on the .wrl file in
the Current Folder browser. For example, double-clicking a .wrl file in the
Current Folder browser now starts the Simulink 3D Animation viewer for
that .wrl file. In previous releases, double-clicking a .wrl file in the current
folder browser started the MATLAB editor for that file.

Changed vr.canvas Units Property Default
The vr.canvas method Units property default is now 'normalized'. In
the previous release, the default was 'pixels'. The vrgetpref function
DefaultCanvasUnits property controls the default of the vr.canvas Units
property.

Improved Performance of Orbisnap in Remote
Configuration
The performance speed of the Simulink 3D Animation Stand-Alone Viewer
(Orbisnap) has been improved.

19



Simulink® 3D Animation™ Release Notes

Version 5.0 (R2009a) Simulink 3D Animation
This table summarizes what is new in Version 5.0 (R2009a).

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

Yes
Details below

None Bug Reports
Includes fixes

• “Alternate Mode of Virtual Scene Viewer Integrated with MATLAB
Figures” on page 20

• “vrplay Updated” on page 21

• “New Functions” on page 21

• “New Object” on page 21

• “Virtual Scenes Now Open Automatically” on page 21

• “Product Files Moved” on page 21

• “Saving and Restoring the Complete SimState” on page 22

Alternate Mode of Virtual Scene Viewer Integrated
with MATLAB Figures
Alternate mode of virtual scene viewer integrated with MATLAB figures,
enables you to combine the following in the same figure:

• Virtual scenes and Handle Graphics® objects

• Multiple views of a virtual world

• Views of different virtual worlds

This feature also allows for the docking of these figure windows, each of which
can contain different worlds, into split screen MATLAB figure windows.

See “Viewing Virtual Worlds” in the Simulink 3D Animation User’s Guide
for details on this alternate viewer mode, including how to activate it (use
vrsetpref to set the DefaultViewer property to 'internalv5').
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vrplay Updated
The vrplay function now contains virtual scene and player controls in a
single MATLAB figure window.

New Functions
The Simulink 3D Animation product has the following new functions:

• vrcadcleanup

Processes VRML files created by CAD tools for use with Simulink 3D
Animation environment. In previous releases, you manually processed
these files before using them in the Simulink 3D Animation environment.

• vrphysmod

Automatically adds a Simulink 3D Animation scene to SimMechanics
models created from CAD tools. In previous releases, you manually
processed these files before using them in the Simulink 3D Animation
environment.

New Object
This release provides a new object, vr.canvas. This object allows for the
placement of a virtual scene view into a MATLAB figure, with full control of
its position and ability to be combined with other Handle Graphics objects
into one GUI.

Virtual Scenes Now Open Automatically
The associated virtual scene now opens automatically when you open the
model. This behavior occurs even if the Simulink 3D Animation block
associated with the virtual scene is in a subsystem of the model. In previous
releases, the ability to automatically open virtual scenes did not work for VR
Sink blocks in subsystems.

Product Files Moved
The Simulink 3D Animation files have moved from matlabroot\toolbox\vr
to matlabroot\toolbox\sl3d.
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Saving and Restoring the Complete SimState
Use the new SimState feature to save the complete simulation state. Unlike
the final states stored in earlier versions of Simulink, the SimState contains
the complete simulation state of the model (including block states that are
logged). You can then restore the state at a later time and continue simulation
from the exact instant at which you stopped the simulation. See “Saving and
Restoring the Simulation State as the SimState” in the Simulink User’s Guide.
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Version 4.8 (R2008b) Virtual Reality Toolbox
This table summarizes what is new in Version 4.8 (R2008b).

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

Yes
Details below

None Bug Reports
Includes fixes

New features and changes introduced in this version are:

• “New VR Tracer Block” on page 23

• “Updated vrnode Method” on page 23

• “New vrworld Method” on page 23

• “New Demo” on page 23

New VR Tracer Block
New VR Tracer block enables visualization of trajectories in virtual scenes.

Updated vrnode Method
The vrnode method now reflects support for the VRML USE reference.

New vrworld Method
The vrworld/addexternproto method is new for vrworld. This function
enables the addition of an EXTERNPROTO declaration to the virtual world.

New Demo
The vrtkoff_spacemouse demo is new in this release. It illustrates how to
use a space mouse compatible device via the MATLAB interface. This demo
requires a space mouse or compatible device.
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Version 4.7 (R2008a) Virtual Reality Toolbox
This table summarizes what is new in Version 4.7 (R2008a):

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

Yes
Details below

None Bug Reports
Includes fixes

New features and changes introduced in this version are:

• “VR Sink Block Now Supports Matrix Signals as Input” on page 24

• “New vrworld Object Option” on page 24

• “Enhanced vrplay Shortcut Keys” on page 24

• “New Demos” on page 25

VR Sink Block Now Supports Matrix Signals as Input
The Virtual Reality Toolbox™ product now supports matrix-type data input
for the VR Sink block. Previously, only the MATLAB interface supported
matrices (MFxx fields). The Simulink interface supported only vectors (SFxx
fields). Now, both MATLAB and Simulink interfaces support matrices (MFxx
fields).

New vrworld Object Option
The vrworld object has a new option, new. This option enables the creation
of a new virtual world object, even if another vrworld object associated with
the same VRML file already exists.

Enhanced vrplay Shortcut Keys
The vrplay function shortcut keys have changed as follows:

• The Page Up and Page Down keys have the same functionality as the R
(rewind) and F (forward) shortcut keys, respectively. These keys perform
rewind and forward operations on the animation file you are playing.
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• The p shortcut key toggles between play and pause behavior.

New Demos
The following demos are new in this release:

• vrmorph

• vr_octavia_video

• vrtkoff_trace
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Version 4.6 (R2007b) Virtual Reality Toolbox
This table summarizes what’s new in Version 4.6 (R2007b):

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

Yes
Details below

None Bug Reports
Includes fixes

New features and changes introduced in this version are

New VR To Video block
New VR To Video block allows RGB video stream output for further 2D
video processing.

Joystick and Space Mouse Input Functionality Added
to MATLAB Toolbox Interface
New vrjoystick and vrspacemouse objects can interface with joysticks and
space mouse input devices.

Joystick and Space Mouse Input Support Added for
Linux
Joystick and space mouse input support is added for both 32-bit and 64-bit
Linux operating systems.

New Axes Transformation and Math Functions
New axes transformation and math functions are added to the MATLAB
toolbox interface. These are:

• vrdir2ori to convert viewpoint direction to orientation.

• vrori2dir to convert viewpoint orientation to direction.

• vrrotmat2vec to convert rotation from matrix to axis-angle representation.

• vrrotvec to calculate a rotation between two vectors.
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• vrrotvec2mat to convert rotation from axis-angle to matrix representation.

Magellan Space Mouse Block Renamed to Space
Mouse Input
The Magellan Space Mouse block is renamed to Space Mouse Input.
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Version 4.5 (R2007a) Virtual Reality Toolbox
This table summarizes what’s new in Version 4.5 (R2007a):

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

Yes
Details below

No Bug Reports
Includes fixes

New features and changes introduced in this version are

Full-Screen Mode in Virtual Reality Toolbox Viewer
and Orbisnap Stand-Alone Viewer
Fullscreen mode, in which the menu bar and toolbar are switched off,
is implemented in the Virtual Reality Toolbox viewer and the Orbisnap
stand-alone viewer.
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Version 4.4 (R2006b) Virtual Reality Toolbox
This table summarizes what’s new in Version 4.4 (R2006b):

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

Yes
Details below

Yes—Details labeled
as Compatibility
Considerations, below.
See also Summary

Bug Reports
Includes fixes

New features and changes introduced in this version are

VR Text Output Block Added
The VR Text Output block allows Simulink signal values to be displayed as
text in VRML scenes.

Frames Per Second Added to AVI File Playback
Options
It is now possible to specify the frames per second displayed during the
playback of AVI files.

New 3Dconnexion Devices
SpacePilot and SpaceBall 5000 have been added to the list of devices
supported by Magellan Space Mouse block.

Joystick Input Block
The Joystick Input block joystick yaw and throttle controls have switched
behaviors.

Compatibility Considerations
If you have models that contain this block, and you want to use that model
in a Virtual Reality Toolbox version later than 4,3, you must reorder the
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axes. You can do so by placing the Simulink Selector block after the Joystick
Input block in the model.
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Version 4.3 (R2006a) Virtual Reality Toolbox
This table summarizes what’s new in Version 4.3 (R2006a):

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

Yes
Details below

No Bug Reports
Includes fixes

New features and changes introduced in this version are

New Utilities Library
A new library Utilities is added to the Virtual Reality Toolbox block
library vrlib. This library contains the blocks Rotation Matrix to VRML
Rotation, Viewpoint Direction to VRML Orientation, Rotation between
2 Vectors, Normalize Vector, and Cross Product. See “Block Reference”
for details.

VR Animation Playback Controls
A new vrplay GUI is added, which allows playback control of VRML
animation files
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Version 4.2.1 (R14SP3) Virtual Reality Toolbox
This table summarizes what’s new in Version 4.2.1 (R14SP3):

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

No No Bug Reports
Includes fixes
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Version 4.2 (R14SP2+) Virtual Reality Toolbox
This table summarizes what’s new in Version 4.2 (R14SP2+):

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

Yes
Details below

No Known problems

New features and changes introduced in this version are

Virtual Reality Toolbox Support of MATLAB Compiler
Product
The Virtual Reality Toolbox product now supports the MATLAB® Compiler™
product. With this capability, you can use the MATLAB Compiler software
to take MATLAB files as input and generate redistributable, stand-alone
applications that include Virtual Reality Toolbox functionality, including the
Virtual Reality Toolbox viewer. The Virtual Reality Toolbox product does not
support the MATLAB Compiler product for the HP-UX platform.

Virtual Reality Toolbox Viewer
The following changes were made to the viewer:

• The Virtual Reality Toolbox viewer Recording menu has changed to
support frame captures in addition to animation recording.

• The Virtual Reality Toolbox toolbar now has a camera icon that you can
click to capture a frame of the current virtual scene.

Virtual Reality Toolbox Preferences Dialog
The Virtual Reality Toolbox preferences dialog, available through the
MATLAB desktop File -> Preferences dialog, has been updated as follows:

• The Virtual Reality Figure pane is now organized by tabs.
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• The Virtual Reality Toolbox preferences dialog now provides frame capture
preferences. These are available through the Frame Capture tab of the
Virtual Reality Figure pane.

vrsetpref and vrgetpref Changes
The vrfigure set and get functions now include the following properties
to support frame capturing:

• CaptureFileFormat

• CaptureFileName

Space Mouse Block Enhancement
The Magellan Space Mouse block now allows you to specify upper and lower
position coordinate limits for the mouse. The following parameters were
added:

• Limit position— Determines whether you can limit the upper and lower
positions of the mouse.

• Lower position limit — Position coordinates for the lower limit of the
mouse.

• Upper position limit — Position coordinates for the upper limit of the
mouse.
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Version 4.1 (R14SP2) Virtual Reality Toolbox
This table summarizes what’s new in Version 4.1 (R14SP2):

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

Yes
Details below

No Fixed bugs

New features and changes introduced in this version are

Virtual Reality Toolbox Stand-Alone Viewer
The Virtual Reality Toolbox product now includes Orbisnap. This is a free,
optional, and multiplatform stand-alone VRML viewer that does not require
you to have either MATLAB or Virtual Reality Toolbox products. You can
use Orbisnap to

• View prerecorded WRL animation files

• Remotely view, from a client machine, a virtual world loaded in a current
session of the Virtual Reality Toolbox software

• View and navigate, but not simulate, a VRML world or scene

Virtual Reality Toolbox Viewer
The Virtual Reality Toolbox viewer now allows you to interactively set the
vrfigure maximum texture size through the Rendering menu.
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Version 4.0.1 (R14SP1) Virtual Reality Toolbox
This table summarizes what’s new in Version 4.0.1 (R14SP1):

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

No Yes—Details labeled
as Compatibility
Considerations, below.
See also Summary.

Fixed bugs

VR Source block
The VR Source block has been removed from the Virtual Reality Toolbox
product.

Compatibility Considerations
If you had models that made use of this block, you will need to remove any
references to it before your model will simulate using this release.
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Version 4.0 (R14) Virtual Reality Toolbox
This table summarizes what’s new in Version 4.0 (R14):

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

Yes
Details below

No Fixed bugs

New features and changes introduced in this version are

• “Improved Overall Performance” on page 37

• “Tracing and Offline Animation Files” on page 38

• “Improved Virtual Reality Toolbox Viewer” on page 39

• “Double-Clicking VR Sink Blocks Behavior Changed” on page 40

• “Extended Support of Data Types” on page 40

• “Improved Timing Control” on page 40

• “HP-UX Platform Support” on page 41

• “New vrfigure Object Functions” on page 41

• “Joystick Input and Magellan Space Mouse Block Updates” on page 41

• “New and Updated Demos” on page 42

• “Virtual Reality Toolbox Simulink Blocks Updates” on page 42

• “VR Sink and VR Source Block Source File” on page 42

• “MATLAB Interface Updates” on page 43

• “Preferences Changes” on page 43

• “vrworld Object Property Updates” on page 46

• “vrfigure Object Property Updates” on page 47

Improved Overall Performance
Infrastructure changes have improved the overall performance of the Virtual
Reality Toolbox software.
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Tracing and Offline Animation Files
The Virtual Reality Toolbox product enables you to record animations of
virtual scenes that are controlled by the Simulink or MATLAB products.
You can then later play back these animations offline (in other words,
independent of the MATLAB, Simulink, or Virtual Reality Toolbox). You can
save animation data in the following formats:

• 3-D VRML — The Virtual Reality Toolbox software traces object
movements and saves that data into a VRML file using VRML97 timers
and position/orientation interpolators. During the simulation, the product
creates interpolators and saves key and interpolation data values for
all the controlled movable objects in the scene. After the simulation is
stopped, the product saves the entire original VRML scene with the added
timers/interpolators into a user-specified VRML file.

You can then view these files with the Virtual Reality Toolbox viewer. 3-D
VRML files typically use much less disk space than Audio Video Interleave
(AVI) files. If you make any navigation movements in the Virtual Reality
Toolbox viewer while recording the animation, the Virtual Reality Toolbox
software does not save any of these movements.

• 2-D AVI — The Virtual Reality Toolbox software traces object movements
and writes animation data into an Audio Video Interleave (AVI) file using
the Virtual Reality Toolbox vrfigure/capture method and the MATLAB
avifile function. Because avifile can record the exact 2-D snapshot
of each figure window, the recorded 2-D animation reflects exactly what
you see in the viewer window. It includes any navigation movements you
make during the recording.

This functionality has been integrated into the Virtual Reality Toolbox viewer.

You can also save animation data through the MATLAB interface. This
functionality has been integrated into the vrworld and vrfigure methods.
See “MATLAB Interface” in the Virtual Reality Toolbox User’s Guide
documentation for procedures on how to save animation data.

Notes when working with animation data:

• If you distribute the resulting VRML animation file, be sure to also
distribute all the inlined object and texture files referenced in the original
VRML world file.
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• While recording 2-D AVI animation data, always ensure that the Virtual
Reality Toolbox viewer is the topmost window and fully visible. Graphics
acceleration limitations might prevent the proper recording of 2-D
animation otherwise.

• For the creation of animation files, timing is an important issue. When you
create animation files that are controlled from the Simulink interface, the
timing properties that control when the recording is started and stopped,
and when each data snapshot (3-D) or animation frame (2-D) is saved, are
related to the Simulink time. To better capture the scene dynamics, you
might want to change the Sample time parameter of the VR Sink block
parameter.

When you create animation files that are controlled from the MATLAB
interface, you need to programmatically advance the time in the virtual
scene.

Improved Virtual Reality Toolbox Viewer
The Virtual Reality Toolbox viewer has been completely updated and
improved. In addition to the original Navigation Panel at the bottom of
the window, the Virtual Reality Toolbox viewer now has a menu bar and
associated toolbar. These additional areas allow you to perform a number of
operations on the loaded virtual world, including

• Start the V-Realm Builder editor

• Perform navigation and rendering operations

• Work with, add, and remove viewpoints

• Start and stop model simulation

• Edit VR block parameters

• Record animations of the model simulation. You can later play back the
animation files without Virtual Reality Toolbox or other MATLAB product.

In addition, the Virtual Reality Toolbox software has been enhanced for better
VRML97 compatibility, including:

• Proper handling of PROTO nodes

• Improved VRMLScript processing
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• Improved texture rendering, allowing for resolution to the hardware limit
of your video card

• Improved rendering of transparent images

In addition, the Virtual Reality Toolbox viewer keyboard navigation has
changed.

Double-Clicking VR Sink Blocks Behavior Changed
The behavior of a VR Sink block when you double-click it has changed as
follows:

1 The first time you add a VR Sink block to a model, double-clicking that
block displays the block parameter dialog for that block.

2 After configuration is complete and you make an association with a virtual
world, double-clicking the VR Sink block displays the Virtual Reality
Toolbox viewer for that model.

To display the block parameter dialog for the VR Sink block in the
Virtual Reality Toolbox viewer, select the Simulation menu, then Block
Parameters.

Extended Support of Data Types
The Virtual Reality Toolbox product now supports a number of MATLAB
data types. In earlier releases, the MATLAB product only supported a data
type of double. The Virtual Reality Toolbox product provides an interface
between the MATLAB and Simulink environment and VRML scenes. With
this interface, you can set and get the VRML scene node field values. The
setfield and getfield vrnode methods have been updated to work with
these new data types.

Improved Timing Control
The time in virtual scenes advances independently of MATLAB and Simulink
interfaces. As a result, if you define dynamic actions directly in the VRML
world, these actions cannot interact appropriately with object actions
controlled by Virtual Reality Toolbox through the MATLAB or Simulink
interface. To compensate for this, the Virtual Reality Toolbox product now
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provides two vrworld properties, Time and TimeSource. The Time property
contains the current time in the virtual world. The TimeSource property
defines the source of the time for the virtual world. The TimeSource property
can take the following values:

• 'external' — This is the default value. This property value specifies
that an external source controls the time in a virtual world (in other
words, all Virtual Reality Toolbox viewer windows). This external
source can be either from the Simulink interface, using the simulation
time, or from the MATLAB interface, using the vrworld method
set(w,'Time',time_value). The 'external' property value eliminates
the unpredictable interferences between the Simulink software and
internal virtual world time and ambiguities in interpreting the time in
the virtual world.

• 'freerun'— This property value specifies that the time in virtual worlds
advances independently based on the system timer. You can still set the
time from which the virtual world clock starts advancing with the vrworld
method set(w,'Time',time_value).

HP-UX Platform Support
The Virtual Reality Toolbox product is now supported on Hewlett-Packard™
UNIX® (HP-UX) 11.00.

New vrfigure Object Functions
The vrfigure object has two new methods:

• vrgcf— Gets the handle for a currently active virtual reality figure. It is
most useful to query and set virtual reality figure properties.

• vrgcbf— Gets the current callback virtual reality figure.

Joystick Input and Magellan Space Mouse Block
Updates
When you place the Joystick Input and Magellan Space Mouse blocks in
disabled subsystems, these blocks no longer require that actual hardware be
connected to the computer for the model to run. This allows you to create
models with alternative user interfaces, switchable according to the actual
hardware configuration.
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New and Updated Demos
New and updated demos in Release 14 are listed in the table below. You can
open the demos by entering the corresponding model names in the MATLAB
Command Window.

Title Model Name

Portal Crane with Joystick Control vrcrane_joystick

Portal Crane with Predefined
Trajectory

vrcrane_traj

Heat Transfer Visualization with
2-D Animation

vrheat_anim

Vehicle Dynamics Visualization vr_octavia

Virtual Reality Toolbox Simulink Blocks Updates
The Simulink block library for the Virtual Reality Toolbox product has the
following block updates:

• VR Sink blocks now accept all meaningful data types as input. It converts
these data types to natural VRML types as necessary. These data types
include logical values, many types of signed and unsigned integers, singles,
and doubles.

• VR Source blocks now output signals of data types corresponding to the
natural VRML data types of the associated fields. These data types include
logical values, many types of signed and unsigned integers, singles, and
doubles.

• Space Mouse Input blocks now support USB devices (such as the SpaceBall
input device), and the SpaceTraveler motion controller.

• Joystick Input blocks now support force-feedback devices such as
force-feedback joysticks, steering wheels, and haptic devices. To use this
functionality, you must install DirectX® Version 8.0 or later.

VR Sink and VR Source Block Source File
The behavior of the VR Sink and VR Source block Source file text field has
changed as follows:

42



Version 4.0 (R14) Virtual Reality Toolbox™

• Browsing to a file enters that filename in the text field, with a path relative
to the Simulink model location. For example, if the VRML file resides
in <Simulink model location>\vrml\vrbounce.wrl, the filename that
appears in the text field is vrml\vrbounce.wrl.

• If a model has a VRML file associated with it, the Virtual Reality Toolbox
product searches the path associated with that file. If the product does
not find the file on this path, it then searches for the filename using the
MATLAB path value.

• If you enter an absolute and fully qualified path for the VRML file, the
Virtual Reality Toolbox software searches just that path for the file.

MATLAB Interface Updates
Associated with the support of extended data types, the MATLAB interface
vrsetpref and vrgetpref functions now set and get the following new
preferences in addition to earlier preferences.

Preferences Changes
The Virtual Reality Toolbox software lets you specify preference settings
so that you can define the default behavior of the Virtual Reality Toolbox
software. The preferences functionality has the following changes:

• The ability to set Virtual Reality Toolbox preferences has moved from
the VR Sink/Source blocks to the standard MATLAB preference system
accessible through the MATLAB main window File -> Preferences menu
item.

For this release, you can set only the preferences for HttpPort,
VrPort, Editor, and TransportBuffer preferences using the MATLAB
Preferences menu. To get or set the full set of preferences, use the
functions vrgetpref and vrsetpref.

• The following preferences have been added to the Virtual Reality Toolbox
software. For preferences that begin with the string DefaultFigure or
DefaultWorld, these values are the default values for the corresponding
vrfigure or vrworld property.
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Preference Description

DataTypeBool Specifies the handling of
the VRML Bool data type
for vrnode/setfield and
vrnode/getfield. Valid values
are 'logical' and 'char'. If set
to 'logical', the VRML Bool data
type is returned as a logical value.
If set to 'char', the Bool data type
is returned 'on' or 'off'. Default
is 'logical'.

DataTypeInt32 Specifies handling of the
VRML Int32 data type
for vrnode/setfield and
vrnode/getfield. Valid values
are 'int32' and 'double'. If set
to 'int32', the VRML Int32 data
type is returned as int32. If set to
'double', the Int32 is returned as
'double'. Default is 'double'.

DataTypeFloat Specifies the handling of
the VRML float data type
for vrnode/setfield and
vrnode/getfield. Valid values
are 'single' and 'double'. If set
to 'single', the VRML Float and
Color data types are returned as
'single'. If set to 'double', the
Float and Color data types are
returned as 'double'. Default is
'double'.

DefaultFigureAnti
Aliasing

Determines whether antialiasing is
used by default for new vrfigure
objects. Valid values are 'off' and
'on'.
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Preference Description

DefaultFigureDeleteFcn Specifies the default callback
invoked when closing a vrfigure
object.

DefaultFigureLighting Specifies whether the lights are
rendered by default for new
vrfigure objects. Valid values are
'off' and 'on'.

DefaultFigureMax
TextureSize

Specifies the default maximum
pixel size of a texture used in
rendering new vrfigure objects.
Valid values are 'auto' and 32 <=
x <= video card limit, where x is a
power of 2.

DefaultFigureRecord2D
CompressMethod

Specifies the default compression
method for creating 2-D animation
files for new vrfigure objects.
Valid values are '', 'auto',
'lossless', and 'codec_code'.

DefaultFigureRecord2D
CompressQuality

Specifies the default quality of 2-D
animation file compression for new
vrfigure objects. Valid values are
0-100.

DefaultFigureRecord2D
FileName

Specifies the default 2-D offline
animation file name for new
vrfigure objects.

DefaultFigureStatusBar Specifies whether the status bar
appears by default at the bottom of
the Virtual Reality Toolbox viewer
for new vrfigure objects. Valid
values are 'off' and 'on'.

DefaultFigure
Transparency

Specifies whether or not
transparency information is
taken into account when rendering
for new vrfigure objects. Valid
values are 'off' and 'on'.
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Preference Description

DefaultFigureWireframe Specifies whether objects are drawn
as solids or wireframes by default
for new vrfigure objects. Valid
values are 'off' and 'on'.

DefaultWorldRecord3D
FileName

Specifies the default 3-D animation
file name for new vrworld objects.

DefaultWorldRecordMode Specifies the default animation
recording mode for new vrworld
objects. Valid values are 'manual'
and 'scheduled'.

DefaultWorldRecord
Interval

Specifies the default start and
stop times for scheduled animation
recording for new vrworld objects.
Valid value is a vector of two
doubles.

DefaultWorldRemoteView Specifies whether the virtual world
is enabled by default for remote
viewing for new vrworld objects.
Valid values are 'off' and 'on'.

DefaultWorldTimeSource Specifies the default source of
the time for new vrworld objects.
Valid values are 'external' and
'freerun'.

TransportTimeout Amount of time VR server waits
for a reply from the client. If there
is no response from the client, VR
server disconnects from the client.

vrworld Object Property Updates
Associated with the support of animation files, the vrworld object now
supports the following new properties:
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Property Description

Record3D Enables 3D animation recording. Read/write.

Record3DFileName 3D animation file name. The string can contain
tokens that are replaced by the corresponding
information when the animation recording takes
place. Read/write.

Recording Animation recording toggle. This property acts as
the master recording switch. Read/write.

RecordMode Animation recording mode. Read/write.

RecordInterval Start and stop times for scheduled animation
recording. Corresponds to the virtual world object
Time property. Read/write.

Time Current time in the virtual world. Read/write.

TimeSource The source of the time for the virtual world. If
set to 'external', time in the scene is controlled
from the MATLAB interface (by setting the Time
property) or the Simulink interface (simulation
time), if set to 'freerun', time in the scene
advances independently based on the system timer.
Read/write.

vrfigure Object Property Updates
The vrfigure object now supports the following new properties:

Property Description

MaxTextureSize Sets the maximum pixel size of a texture used
in rendering vrfigure objects. The smaller
the size, the faster the texture can render.
Increasing this value improves image quality
but decreases performance. A value of 'auto'
sets the maximum possible pixel size. If the
value you enter is unsuitable, a warning might
trigger. The Virtual Reality Toolbox software
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Property Description

then automatically adjusts the property to the
next smaller suitable value. Read/write.

NavMode Specifies navigation mode. Read/write.

NavSpeed Specifies navigation speed. Read/write.

NavZones Toggles navigation zones on/off. Read/write.

Record2D Enables 2-D offline animation file recording.
Read/write.

Record2DCompress
Method

Specifies the compression method for creating
2-D animation files. The codec_code must be
registered in the system. See the MATLAB
function documentation for avifile. Read/write.

Record2DCompress
Quality

Specifies the quality of 2-D animation file
compression. Read/write.

Record2DFileName Specifies the 2-D offline animation file name.
The string can contain tokens that are replaced
by the corresponding information when the
animation recording takes place. Read/write.

StatusBar Toggles the status bar at the bottom of the
Virtual Reality Toolbox viewer. Read/write.

Toolbar Toggles the toolbar on the Virtual Reality Toolbox
viewer. Read/write.
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Version 3.1 (R13SP1) Virtual Reality Toolbox
This table summarizes what’s new in Version 3.1 (SP1):

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

Yes
Details below

No Known problems

New features and changes introduced in this version are

Cross-Platform Support
The Virtual Reality Toolbox product is now supported on the Mac OS® X
platform.

Improved Rendering
The overall rendering of virtual worlds for the Virtual Reality Toolbox
interface is improved.

Known Problems

Microsoft Internet Explorer 6.0
Microsoft® Internet Explorer® 6.0 might incorrectly interpret system Java™
library paths, preventing Virtual Reality Toolbox components (such as the
Virtual Reality Toolbox Viewer) from running. Netscape Navigator® users do
not experience this problem.

If you are using Internet Explorer 6.0, you should manually edit the Java
library path for Internet Explorer 6.0. Alternatively, you can also use Internet
Explorer 5.5 with Virtual Reality Toolbox software.

Editing the Java Library Path

To manually edit the Java library path for Internet Explorer 6.0:
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1 Run the regedit command.

2 Go to

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\JavaVM

A list of value names and their values appears.

3 Replace each instance of %systemroot% with the system root path. For
example

C:\WINNT

4 Restart the computer.

Patch Required for the MATLAB Product Running Mac OS X
10.2
The Virtual Reality Toolbox product requires the MATLAB product running
Mac OS X 10.2.

To install the Virtual Reality Toolbox product on Mac OS X, you must first
install a patch available from MathWorks. To get the patch, go to
ftp://ftp.mathworks.com/pub/tech-support/solutions/s33053. Refer to
this location for any updates. Refer to http://www.mathworks.com/support
for updated instructions. The instructions for this patch are below.

You should download this patch if you match one of these scenarios:

• You want to install MATLAB Release 13 on a Mac OS X 10.2 system that
does not currently have theMATLAB product installed.

• You want to update an installation of the MATLAB product that was
installed on a system with the Mac OS X product 10.1.x, but has
subsequently been updated to the Mac OS X product 10.2.

• You want to update an installation of the MATLAB product that is installed
on a system with Mac OS X 10.1.x.

• You already updated the MATLAB product installed on a system with Mac
OS X 10.1.x, as in scenario III above, and have subsequently updated to
Mac OS X 10.2.
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Depending on which scenario you choose, please follow the directions below.

The first step is to download the MathWorks Jaguar® Updater disk image
from ftp://ftp.mathworks.com/pub/tech-support/solutions/s33053.
This file is named MathWorks_Jaguar_Updater.dmg. Place this file on your
desktop. Double-click the file to start the Disk Copy utility, which will mount
the disk image as a virtual disk named MathWorks_Jaguar_Updater. You
will use this MathWorks_Jaguar_Updater virtual disk in the following
installations.

Next, locate your scenario and follow the steps listed for that scenario.

Scenario I. You want to install MATLAB Release 13 on a Mac OS X 10.2
system that does not currently have the MATLAB product installed.

1 Insert the MATLAB Release 13 install CD titled CD 1 of 3 into your CD
drive.

2 Wait a few moments for Mac OS X to mount the CD. When the
MathWorks_R13_1 volume appears on your desktop, you can proceed.

3 Double-click on the Install for Mac OS X icon in the
MathWorks_Jaguar_Updater virtual disk.

4 Follow the instructions presented by the installer.

5 After the installer finishes, drag the MathWorks_R13_1 volume to the
trash to eject the CD, and repeat steps 1 through 4 with CD 2 of 3 and
CD 3 of 3.

Scenario II. You want to update an installation of the MATLAB product that
was installed on a system with Mac OS X 10.1.x, but has subsequently been
updated to Mac OS X 10.2.

1 Double-click on the XFree86_4.2.0.1-10.2 icon in the
MathWorks_Jaguar_Updater virtual disk.

2 Follow the instructions presented by the XFree86 updater. Accept any
default values presented.
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3 Double-click on the MATLABR13_Jaguar_patch icon in the
MathWorks_Jaguar_Updater virtual disk.

4 Follow the instructions presented by the MATLAB updater. When
asked to choose the folder where the MATLAB product is installed click
Next unless the MATLAB product is not installed the default location
(/Applications/MATLAB6p5). If the MATLAB product is not installed in
the default location, click the Choose... button and navigate to the folder
where you installed the MATLAB product.

Scenario III. You want to update an installation of the MATLAB product
that is installed on a system with Mac OS X 10.1.x.

1 Double-click on the MATLABR13_Jaguar_patch icon in the
MathWorks_Jaguar_Updater virtual disk.

2 Follow the instructions presented by the MATLAB updater. When
asked to choose the folder where the MATLAB product is installed click
Next unless the MATLAB product is not installed the default location
(/Applications/MATLAB6p5). If this is the case, then click the Choose...
button and navigate to the folder where you installed the MATLAB product.

Scenario IV. You already updated the MATLAB product installed on a
system with Mac OS X 10.1.x, as in scenario III above, and have subsequently
updated to Mac OS X 10.2.

1 Double-click on the XFree86_4.2.0.1-10.2 icon in the
MathWorks_Jaguar_Updater virtual disk.

2 Follow the instructions presented by the XFree86 updater. Accept any
default values presented.
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Version 3.0 (R13) Virtual Reality Toolbox
This table summarizes what’s new in Version 3.0 (R13):

New Features and Changes Version Compatibility
Considerations

Fixed Bugs and Known
Problems

Yes
Details below

Yes—Details labeled
as Compatibility
Considerations, below.
See also Summary.

No bug fixes

New features and changes introduced in this version are

Cross-Platform Support
Virtual Reality Toolbox software Version 3.0 is supported on both PC and
UNIX platforms.

Virtual Reality Toolbox Viewer
Virtual Reality Toolbox software Version 3.0 now contains a VRML viewer.
You can use this viewer on all supported operating systems. With the Virtual
Reality Toolbox viewer, you can move between predefined viewpoints in
a virtual scene. You can also control the navigation method, speed, and
rendering of the virtual world. From the MATLAB interface, you can control
the Virtual Reality Toolbox viewer better than other VRML-enabled Web
browsers.

Improved Performance
The communication between Virtual Reality Toolbox and VRML-enabled Web
browsers is improved. You are now able to perform such tasks as controlling
multiple objects in a virtual scene or setting multiple field values faster
than before.

Improved MATLAB Interface
It is now easier to access and manipulate virtual world objects from the
MATLAB command line. You can use dot notation to change object properties.
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Also, multiple field values are transferred between MATLAB and the Virtual
Reality Toolbox server in a form consistent with their VRML representation.

Customized V-Realm Object Libraries

Compatibility Considerations
If you are on a PC platform and you created your own object libraries in
V-Realm while using Virtual Reality Toolbox software Version 2.0, deleting
the MATLAB product deletes these custom libraries. You need to save these
libraries before uninstalling the older version of the MATLAB product:

1 Save the contents of the <MATLAB root>\toolbox\vr\vrealm folder to
another location on your system.

2 Uninstall the older version of the MATLAB product.

3 Install MATLAB software Version 6.5 (Release 13).

4 Install V-Realm using the command

vrinstall -install editor

5 Save the files from your old vrealm folder into the new vrealm folder.

MATLAB software Version 6.5 should have the same folder structure as
your previous version of the MATLAB product. If the folder structure is not
identical, search your system for vrbuild2.ini. Edit the relative paths
within this file to reflect the folder structure of MATLAB software Version 6.5.

After you have moved your files into the new vrealm folder and customized
your vrbuild2.ini file, do not reinstall the V-Realm editor. The command

vrinstall -install editor

replaces the existing vrbuild2.ini file with the default template file.
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Simulink 3D Animation Compatibility Summary
This table summarizes new features and changes that might cause
incompatibilities when you upgrade from an earlier version, or when you
use files on multiple versions. Details are provided in the description of the
new feature or change.

Version (Release) New Features and Changes with
Version Compatibility Impact

Latest Version
V6.0 (R2011b)

None

V5.3 (R2011a) None

V5.2 (R2010b) See the Compatibility
Considerations subheading
for this change:

• “3D World Editor” on page 12V5.1.1 (R2010a) None

V5.1 (R2009b) See the Compatibility
Considerations subheading
for this change:

• “Alternate Mode of Virtual Scene
Viewer Now Default” on page 18

V5.0 (R2009a) None

V4.8 (R2008b) None

V4.7 (R2008a) None
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Version (Release) New Features and Changes with
Version Compatibility Impact

V4.6 (R2007b) None

V4.5 (R2007a) None

V4.4 (R2006b) See the Compatibility
Considerations subheading
for this change:

• “Joystick Input Block” on page 29V4.3 (R2006a) None

V4.2.1 (R14SP3) None

V4.2 (R14SP2+) None

V4.1 (R14SP2) None

V4.0.1 (R14SP1) See the Compatibility
Considerations subheading
for this change:

• “VR Source block” on page 36

V4.0 (R14) None

V3.1 (R13SP1) None

V3.0 (R13) See the Compatibility
Considerations subheading
for this change:

• Customized V-Realm Object
Libraries
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